By : Imam Suharjo email: imam_te@yahoo.com url: http://imm.web.id
Blog : http://lahir.wordpress.com or http://kesini.blogspot.com

Dasar-dasar Nge-Blog Wordpress.com

Dokumen Ini adalah Bebas, bebas di distribusikan dengan bebagai media yang ada dengan syarat tidak

mengurangi dan menambahi isi dari tutoral ini. Bisa ditulis ulang dengan tetap mencantumkan sumber

yang ada. Jika pada dokumen ini mungkin terdapat kesalahan silahkan email ke imam_te@yahoo.com
untuk penjelasan dan perubahan. Terima kasih

Sedikit Tentang Blog
Jenis Blog : Domain sendiri & Penyedia layanan Blog
Penyedia Layanan Blog gratis : www.wordpress.com www.bloger.com

www.Blogspot.com www.multiply.com dll.

Apa yang bisa dilakukan dengan Blog (manfaat blog) :

Lebih gaul (tidak gaptek), internet tidak hanya email dan chating saja
Identitas baru di kartu nama : Nama, telp, Email, Blog .....

Rajin menulis, tulisan bisa dibaca orang di komentari, ditanggapi dll
Menjadi orang yang lebh sabar, terbuka dan menerima masukan dari orang
lain.

= Belajar mengelola website

= Dikenal banyak orang, menambah teman (banyak komunitas)

= Bisa menghasilkan uang (jika dkelola secara profesional)

Kerugian punya Blog :
» Dimarahi orang tua/pacar, uang jajan “internet” jadi lebih banyak ©
= Sakit mata karena radiasi monitor ©
= Sakit Maag karena lupa makan © dll

Banyak macam Blog, saya hanya akan membahas bagaimana membuat dan
menggunakan Blog dengan memanfatkan penyedia layana dari wordpress.com.
Kenapa Worpress.com? Antara lain karena : Gratis, Simple, mudah, aneka bahasa,
Stabil, komunitas melimpah, dll.

Apa seh Wordpress?

Wordpess merupakan sebuah CMS (Content Management Service), skrip web yang
mudah digunakan/diatur dan diisi dengan konten-konten/fitur/thema yang update.
Sementara Wordpress.com merupakan penyedia layanan Blog menggunakan “CMS
Wordpess” gratis pada saat ini ditulis (Maret 2008). Calon pengguna bisa
mendaftarkan secara gratis dan akan mendapatkan blog sub-domain
(nama.wordpress.com) hanya dalam hitungan detik. Tergantung kecepatan menulis
dan koneksi internet kita. ©

Wordress dikembangkan oleh komunitas www.wordpress.org, disini disediakan source
code Worpress yang bisa di download jika anda mempunyai website sendiri / hanya
sekedar untuk mencoba-coba di komputer lokal (Insya Allah segera ada tutorialnya
sendiri). Penulis sendiri baru mengenal Worpress sekitar awal tahun 2005 (waktu
gempa Bantul) ada sebuah website Gempa yang menggunakan Wordpress.

Akan saya bagi menjadi beberapa bagian, mungkin tidak semua bisa langsung mudah
dipahami (perlu watktu). Ini juga belum lengkap, tidak semua fungsi da pengaturan
saya tuliskan :
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Syarat membuat blog Wordpress apa saja?

1. Ada koneksi Internet (untuk Blog yang Online) ©

2. Minimal bisa menggunakan Komputer (menghidupkan, mematikan, mengetik,
sedikit menggunakan internet)

3. Sudah punya email (meskipun tidak harus tetapi ini sangat saya anjurkan)

4. Anda tidak harus bisa chating, YM, download, upload, dll

5.

Sedikit bisa bahasa inggris (yang kurang mudah-mudahan modul ini bisa
menolong)

Bagaimana Cara membuat Blog Wordpress?

Singkanya hanya : Create, login dan Tulis.

Buka Browser kesayangan anda (Internet Explorer, Mozilla Firefox, Opera
atau yang lain.

Buka http://wordpess.com atau http://www.wordpess.com (sama saja).
Ini adalah halaman depan penyedia Blog Sepert terlihat pada Gambar 1.

D=ur=ch
Portugués do Brasil
2 Frangais
Ikaliano
, Eshass Indonesia
donesia.

Sigm Lip Features Support

| Medsrlands
Swenska
| Portuguss
Torkge
tore Langusgass

Already Hip? Right MNowe inn Tags More =
Username: = oo

I Boolas

Passwveord: Craltiare

| Entertainrnent

I Remember me e | Ewvents

Gambar 1 Halaman depan Wordpress.com (bagian kanan)

Anda bisa memilih bahasa yang diinginkan (dimodul ini saya memilih
bahasa Inggris). Anda yang mau menggunakan opsi bahasa indonesia juga
sudah disediakan.

Pilih “Sign Up Now” atau “Sign Up”
Catatan : Ada form username dan password digunakan jika anda sudah
mempunyai username di Wordpress ini.

Username: =5 =
luser yg diinginkan

(Must be at least 4 characters, letters and numbers only.)

Password:

Confirm:

Use upper and lower case characters, numbers and symbols like
password.

Password Strenith:

Email Address: =
|| mam_te@yahoo.com

(vWe send important administration notices to this address so trip

Legal flotsam: M I have read and agree to the fascinating terms of service.

“= Simme a blog! (Like usermname. wordprass. com)
© Just a username. please,

Gambar 2. Pendaftaran nama username
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= |si USERNAME dengan nama yang anda inginkan (minimal 4 kakater,
username bisa berbeda nama dengan blog kita nantinya). Namun saya
sarankan username ini nantinya yang digunakan sebagai Blogname anda.
Ya, setidaknya untuk mempermudah mengingat, tetapi jika anda
mempunyai pertimangan lain tentu tidak masalah. © ,

= PASSWORD diisikan dengan password yang anda inginkan 2 kali mengisi.
Saya dan wordpress menyarakan password yang mudah anda ingat,
sebaiknya gabungan antara hurf dan angka, untuk menjaga keamanan.
Jika_password anda bagus/sangat bagus (susah ditebak) akan mendapat
peringkat Good atau Very Good.

= Isikan EMAIL ADDRESS anda dengan benar, ini akan sangat membantu
anda dalam pengeleloaan blog anda. Terutama jika anda lupa dengan
password anda nantinya.

= (Centang pada bagian depan “l have read and agree...“ sebagai pernyataan
anda telah meneyetujui peraturan yang dibuat.

» Pilih juga “Gimme a Blog (like username.wordpress.com)”

= Klil Next

» Jika terjadi kesalahan maka akan muncul seperti Gambar 3, silahkan
dibenarkan. Mungkin terjadi kesalahan pada form yang diisikan
sebelumnya.

Get vour own WordPress.com account in seconds

Fill out this one-step form and you'll be blogging seconds later!

TEEEREEX

I********

Confirm:
lahir wordpress.com/
Use upper and lower case characters, numbers and symbols like 1I"E$2%"20( in your

Gambar 3. Jika terdapat kesalahan (nama “gema” sudah digunakan)

= Jika sudah benar (hampir sukses) maka akan terlhat seperti Gambar 4.
Bleg Domain: .
lahir .wordpress.com

(Your sddrass will be domain wordpress com, [t must be at least 4 characters, [etters and
numbers only. It cannot be changed so dhoose carefully!)

BT Tudul Blog kamu. .

Language: What language will you be primanly biogging in?
[ld - Bahmsa Indonesia E]

Privacy: M 1 would ke my blog to appear in search engines e Google and Technorati, and in public
kstings around WordPre ss.com.

Signup »

w

Gambar 4. Pengisian Blog Domain, judul dan bahasa

= BLOG DOMAIN bisa diisikan sama/berbeda dengan username tadi
=  BLOG TITLE : Judul Blog kamu (sesuai dengan yang direncanakan,
sebaiknya mencermnkan isi dari Blog nantinya)
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= LANGUAGE : pilih bahasa utama kamu

= PRIVACY : Sebaiknya tetap dicentang supaya Blog kita mudah di “cari”
oleh mesin pencari seperti Google.

= SIGN UP, jika sukses akan ada tampilan seperti ini

Your account is now active!

You are now logged in as (username Anda).

An email with your username, password, Akismet APl key and important links
has been sent to your email address.

Write a post, change your template or visit the homepage.

Itu berarti Anda sudah berhasil membuat blog. Silahkan login ke blog Anda.

Berikut alamat penting untuk Anda:

= Untuk login, buka: http://nama_blog.wordpress.com/login.php atau
http://nama_blog.wordpress.com/wp-admin .

= |si username (=nama blog) dan password.

= Selamat anda masuk di halaman administrasi

Bagaimana cara Menulis di Blog?

Ada 2 macam tulisan di Wordpress yaitu [Write / Tulis] Post dan Page. Post biasanya
digunakn untuk tulisan yang selalu update misalnya berita/tulisan baru. Page
biasanya untuk tulisan yang bersifat Statis (jarang diubah), mislanya Profil kita,
alamat, dlll.

Dashboard m Manage <Comments Elogroll Presentation  Plugins Users Qptions

Gambar : Menu utama Wordpress

Langkah utama menulis Page/Post :

CONOUTAN WN =

Klik “Write” atau “Tulis” untuk mulai membuat posting.
Edit Tulisan dengan menu Editor

Pilih dan sesuaikan Kategori

Seting pada Discution jika diperlukan

Upload dan Tambahkan Gambar jika diperlukan

Edit Tanggal jika diperlukan

Klik “Publish” atau “Tampilkan”

Lihat hasilnya

Title

Fost
wisual Code

» IABG|§E§E

i
]
1]
I
b
1l
Y
)

Fath: L
Tags (separate multiple tags with commas: cats, pet food, dogs)

Sawe and Continue Editing Save Fublish

Gambar : Form untuk Menulis post/page baru
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Upload
File I Browse.. I

Title

Description

upload » |

Gambar : Form untuk Upload dokumen pendukung (Gambar/file lain)

Gambar menu-menu yang ada disebelah kanan saat menulis Categories
new page/post, antar lain untuk :

Add

1' Memlhh kategori page/pOSt Separate multiple categories
2. Diskusi (Allow Comment / boleh dikementai) with commas.

3. Password pada tulisan ™ about Unwarma

4‘ Stams post/page ! ArtikelTeknoIoii

5. Edit tanggal page/post

W Allow Cornments
W Allow Pings

Discussion

Allow Comments
¥ Allow Comments (memperbolehkan artikel kita
¥ Allow Pings dikomentari pembaca.

Post Slug

Fost Timestarmp

Edit Time Stamp, jika E=llECERe e S eSS ——
tanggal page/post tidak rareh =l e
diinginkan tanggal saat ini. ZZ e PR —

[ Edit tirmestamp

Categories : March =
add  Memilih artikel sesui dengan Qg | |2008 (@ 22 '

Separate multiple caregaries kategori yang dibuat sebelumnya. Atau kita bisa
with carmmas. menambahkan kategori baru dengan cara : Menulis
N kategori baru kemudian di ADD. Sebuah artikel bisa

T About Unwarna . .. .
mempunyai beberapa jenis kategori.

Pengaturan umum (Title, tagline, Discucion,

a. Pengaturan Umum : “OPTION &> GENERAL”

Dashboard Write Manage <Comments EBlogroll Presentation FPlugins  Users

I LA Wiriting  Eeading  Discussion  Privacy  Permalinks  Miscellaneous

Gambar Menu Atas Option - General
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Update Cptions =

Blog title: | Be + Thinking

Tagline: Just another WordPress wehblog
In a few words, explain what this blog is about.

WordPress address {URL): |http:.-"'.-" localhost/ inm. web . id

Blog address {URL): http://localhost/ irmm. web . id
Enter the address here if ywou want wour blog homepage t«

E-mail address: imam_te@yahoo.com
This address is used only for admin purposes.

Membership: T &nmyone can register
P [ Users must be registered and logged in to comment

New User Default Role: | subscriber =]
Gambar Isi Menu General (umum) Atas
Keterangan :
1. Blog Title : Judul Blog
2. Tagline : Keterangan singkat tentang Blog (sebaiknya kata-kata kunci
yang mencerminkan isi Blog)
3. Wordpress Address dan Blog Address adalah alamat URL Blog kita ini.
4. Email : Alamat Email
5. Membership (jika di centang) :
= Anyone can register (semua orang bisa mendaftar)
= User must .......... ( yang bisa memberikan komentar hanya user yang
telah Logon)
6. Aturan bagi setiap User baru
New User Default Role: | subscriber =]

: Administrator
Editor
Author
UTC time is: | Contributor

= Subscriber (default) - Pilih ini saja

= Administrator (mempunyai wewenag penuh)
= Editor

= Author (Penulis)

= Contributor

Update Options »
Jangan Lupa Setiap melakukan perubahanuntuk disimpan !
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Date and Time

UTC time is; 2008-03-18 12:16:25 pm
Times in the blog should differ by: |7 hours (¥our timezone offse

Fij,
Output: March 18, 2008

Default date format:

q:i a
Qutput: FI1€ pm

Default time format:

Documentation on date formattim

Weeks in the calendar should start on: | Monday =]
Gambar Isi Menu General Pengaturan Tipe Tanggal danJam jika diperlukan

b. Beberapa Opsi Default (Standar) yang bisa diganti
“OPTION - DISCISSION”

Dashboard Write Manage Comments Blogroll Presentation Flugins Users

General Writing Feading EMESEESLLE Privacy  Permalinks  Miscellaneous

Discussion Oplbons

Usual settings for an article:
(TThese settings nmuay be overridden for individual articles.)

s W Attermpt to notify amny blogs linked to from the article (slows down posting.)
o W Allow link notifications from other blogs (pingbacks and trackbacks.)

e [ allow people to post camments an the article
E-mail me whenever:

e W Snyorne posts a comment

e W & comment is held for moderation
Before a comument appears:

e [ an administrator must always approve the comment
& W Comment aduthor must fill out name and e—m ail

& W Comment author must hawve a previously approwved comment

Antara lain :
1. Email Me ......... : (jika dicentang) Notifikasi ke email kita jika ada Komentar
baru dan ada komentar yang menunggu persetujuan)
2. Before. ........ : Komentar harus selalu di Approve, Komentar harus mengisikan
Nama dan email, Komentar harus pernah disetujui sebelumnya.

Update Options »
Jangan Lupa Setiap melakukan perubahan untuk disimpan!
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Mengganti Tampilan (Thema):

“PRESENTATION -> THEME”
Menggati Thema, mirip dengan mengganti Thema pada Wndows atau mengangti Skin
pada WinAmp. Thema/skin akan berubah namun isnya tidak berubah.

Dashboard Write Manage Comments Elogroll Flugins Users Qptions

Widgets Theme Editar

Langkah :

Lihat dan Pilih Theme yang diinginkan (KLIK)

APPLY untuk merubah

Lihat tapilan baru.

Anda dapat mecobanya sesui dengan keinginan

Jika diperlukan bisa dilakukan modifikasi pada “THEME EDITOR”

UGAWN =

Menggunakan Widget (KLIK & DRAG)

Widget adalah menu yang bisa mempermudah kita untuk mengisi Menu apda SIDE bar
(Menu Samping : Kanan, Kiri, Atas tergantung dari Theme yang dipilih).

Dashboard Write Manage Comments Blogroll Plugins Users Qptions

Themes Theme Editor

Contoh tampilan Themes yang menyediakan Widgets dengan 2 buah Sidebar :
Sidebar Arrangement

You can drag and drop widgets onto your sidebar belaw,

Save Changes »

Sidebar 1 Sidebar 2
Search Pages =
Categories 1 =
Available Widgets
Archives Calendar Links Meta Eecent Comments Recent Po:

Langkah Penggunaan :
1. Contoh Theme mempunyai 2 buah Sidebar ( 1 dan 2)
2. Widget yang disedakan ada di “AVAILABLE WIDGET”
3. Klik dan Drag salah satu, misalnya “Calender” Letakkan di Salah satu Sidebar,
misalnya sidebar 1.
4. Coba dengan Wdget yang lain.
5. Lihat hasil tampilan Blog anda.

Catatan :
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= Beberapa Widget yang sudah terpasang, bisa dimodifikasi dengan
mengKLIK pada =, sehingga muncul Windows baru
Save Changes »

untuk menyimpan
» Lihat Hasilnya

Sidebar 2

Pages @

Pages =

Title: [Halaman
Sort by | Page ID LI

Exclude:
Fage IDs, separated by commas

Mengedit Post/Page/ Kategori yang sudah ditulis

Adakalanya kta perlu memperbaiki/merubah artikel yang sudah kita tulis
sebelumnya. Untuk melakukan hal ini kita bisa gunakan : MANAGE - PAGE atau
POST.

Dashboard Write Comments Elogroll Presentation Plugins Users Options

Uploads Categories  Files  Import Export

Akan kelihatan list post/page yang pernah kita Tulis, kita bisa melakukan :
1. Melihat dengan - VIEW
2. Meng-edit > EDIT
3. Menghapus - DELETE (Hati-hati Page/Post yang di pilih akan terhapus!)

ID When Title Categories Comments Author

2008-03-17 eramaik ariy, Tech Mews, . .
N,
® 102550 pm MILS Tutarial o el (Edit)
2008-03-17 Google
12507 pm o Gratis??

Tech Mews 8] admin  View Edit Delete
Untuk Pengaturan Kategori bisa dilakukan dengan : MANAGE-> CATEGORIES, Bisa
dilakukan :

1. Penambahan kategori

2. Perubahan/penhapusan Kategori

Categories (add new)

ID MName Description Posts Action
3  Tech Mews g Edit Celete
4  Tutorial 1 Edit Delete
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Mengelola Link

Untuk menambahkan Link rekan kita, kita bisa dengan mudah mengatur dengan
menggunakan BLOGROLL - MANAGE BLOGROLL.

Dashboard ‘Write Manage Comments Jilsls[delil Fresentation Flugins Users Options

[SEUEGTM NI SIN Add Link  |mport Links  Categories

Langkah :
1. Untuk Menambahkan Link Klik add Link
2. Jika diperlukan anda bisa MengEdit/ menghapus Link yang ada.
3. Untuk melihat, Pastikan Widget Link sudah terpasang di Sidebar

Blogroll Management
Here \,.rDD sites that yvou visit often and share them on your blog. When you hawve a list of links in

your sidebar to other blogs, it’s called a “blograll.”

Currently showing | all j links ordered by | Name j Update »

Name URL Categories rel Visible Action [

Dek Ebta

Little Erather ebsoft.aweb.id Link Yes Edit  Delete [~

Gambar Pengaturan Link (Blogroll)
Add Link
Name:

Address: http: //

Description:

Add Link =

Gambar Menu Penambahan Link baru

Mengatur komentar yang masuk

Artikel yang bagus aka menarik banyak komentar dari pembaca dan membuat diskusi
lebih hidup. Tetapi ada kalanya Sebuah komentar dari Pembaca perlu kita edit/hapus
/ rapikan, silahkan menggunakan menu : COMMENTS > COMMENTS

Dashboard ‘Write Manage Elogroll Presentation Flugins Users Options

Comments [t el lels Nt Rl b

Anda bsa melakukan :
1. Pengeditan
2. Penghapusan
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3. Approve (mneyetujui untuk ditampilkan
4. SPAM (jangan Gunakan fitur ini untuk komentar yang buksa benar-benar SPAM)

View Mode | Mass Edit Mode

1. Mr WordPress | wordpress.org | IF:

Hi, this is a comment.
To delete a comment, just log in and wiew the post's comments. There you will
edit ar delete them.

Mar 17, 5:08 PM —{[ | | | ]}— el e

Menggunakan Plug in

Plugin adalah fitur tambahan untuk pengelolaan Blog, anda bisa mengaktif
/deaktifkan Plugins dengan menu ini. Sayangnya tidak banyak Plugin yang diberikan
dari Blog Wordpress.com. Untuk penggunaan Plugin anda silahkan belajar lebih lanjut
©.

Dashboard Write Manage Comments Blogroll Presentation Users Options

Plugins s T=dTd

Plugin Management

Plugins extend and expand the functionality of WordPress. Once a plugin is installed, you may activate it or deactivate it
here.

Plugin Yersion Description Action

Akismet checks your comments against the Akismet web service to see
if they look like spam or not. You need a WordPress.com AP key to use
Akismet 2.1.3 it. You can review the spam it catches under "Comments.” To show off Activate Edit
wour Akismet stats just put <?php akiswet_eounter () 2> inyour
ternplate. See alsor WP Stats plugin. 8y Mart Aullenweq.

This is not just a plugin, it symbaolizes the hope and enthusiasm of an
entire aeneratinn cormmead nnin twen wenrds sonn mooct famoncle bl nnie

Menambah User baru

Sebua

Sebuah Blog bisa terdapat banyak user (banyak pengguna), tiap pengguna bisa
mempunyai user dan password sendiri, menulis artikel dll. Tergantung dari jenis user
yang didaftarkan. Untuk menambahkan user baru mudah dan gampang. User baru
bisa mendaftar sendiri atau kita sebagai pemilik Blog menambahkan secara manual
dengan menu : USER - AUTHOR & USER.

Dashboard ‘Write Manage Comments EBlogroll Presentation  Plugins Options

I Authors & Users IR
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Username
(required)

First Name
Last Mame
E-—mail (required)

Website

Password (twice)

Role
S ber

Administrator
Editar Add User =

Author
Contributor

Gambar Form penambahan user baru secara Manual

Mem-backup Tulisan di Blog dan MengIlmport
a. Mem-Backup (Export)

Dashboard Write Comments Blogroll Presentation Plugins Users Options

Posts Pages Uploads Categories Files  Import [34allgs

Jika Tulisan kta sudah banyak ada baiknya anda membuat cadangan (BackuP) data
yang pernah kita tulis dengan cara
1. Buka menu MANAGE - EXPORT

Optional options

Restrict Author:

Download Export File »
Gunakan :

Simpan File di tempat yang aman
Catatan : File yang terbackup adalah Tulisan (page/post), Komentar, Kategori
tidak termasuk gambar yang pernah di Upload.

A wWwnN

b. Menggunakan File Backup (Import)
Dashboard Write Comments Blograll Presentation  Plugins Users Qptions

Posts Pages Uploads Categories  Files Ehgsllg® Export

Import posts, comments, custom fields, pages, and categories from a
WordPress WardPress export file

Pengaturan Permalink

Permalink adalah tampilan alamat di URL kita, ada beberapa opsi yang bisa dipilih
sesui dengan keigina kita untuk “mempercantik” tampilan URL Blog.
Langkah :

1. Buka OPTIONS - PERMALINK
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2. pilih salah satu Opsi
3. Klik Update Permalink Structure =

Dashboard ‘Write Manage Comments Blogroll Presentation Plugins  Users

General Writing Reading Discussion  Privacy ESGGEULLEN Miscellaneous

_ [ Update Permalink Structure » ]
Common options:

* Default
#» http://localhost/ imm. web . id/ ?p=123

 Date and name based
= http://localhost/ imm. veb. id/ index . php/ 2008/ 03/ 18/ sawp le-post/s

© Mumeric
» http://localhost/imm. web. id/index.php/archives/ 123

' Custam, specify below

Menambahkan URL Blog ke GOOGLE

Secara default setingan : OPTION - PRIVACY adalah Blog kita bisa ditemukan melalui
berbagai mesin pencari (Search Engine). Namun kita bisa merbah tipe Privasi
tersebut.

Dashboard ‘Write Manage Comments Elogroll Presentation Flugins Users

General Writing Feading Discussion QEgpEtal Permalinks  Miscellaneous

& | would like my blog to be wisible to everyone, including search engines (like
Coogle, Sphere, Technorati} and archivers

© | would like to block search engines, but allow normal wvisitors

Update Cptions =

Ada perlunya kita menabahkan URL kita secara manual ke GOOGLE. Supaya Blog kita
bisa dicari Google, salah satu caranya dengan mendaftarkan diri ke ADD URL Google :
Buka www.Google.com/addurl

Isikan Url Blog kita

Tambahkan kata-kata perihal isi Blog kita

Silahkan d Proses

Google perlu memprososes, sehingga belum tentu Blog kta langsung bisa dicari
dengan Google.
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Sumber antara lain :

1. http://wordpress.com

2. http://wordpress.org

3. Fatih Syuhud, Membuat Blog di Wordpress.com
http://afatih.wordpress.com/2007/11/11/membuat-blog-di-wordpress-com/

4. Agus, Bikin blog di Wordpress Yuk!, http://ustadz.net
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